CREATING AN ACCESSIBLE WORD DOCUMENT

CONTENTS

creating an Accessible Word Document............................................................................................................. 1

1. Insert a Document Title ................................................................................................................................. 2

2. Use Headings .................................................................................................................................................. 3

   To insert a Heading: ........................................................................................................................................ 4

   To check the headings hierarchy: ...................................................................................................................... 4

   To format a Heading: ...................................................................................................................................... 4

3. Format Text .................................................................................................................................................... 5

   Emphasis .......................................................................................................................................................... 5

   Design ............................................................................................................................................................. 5

4. Insert Alt-Tags .................................................................................................................................................. 5

5. Insert Hyperlinks ............................................................................................................................................. 6

6. Insert Lists/Columns ..................................................................................................................................... 6

7. Insert Tables .................................................................................................................................................. 7

8. Run WORD Accessibility Check ................................................................................................................ 8

9. Save the Word Document as a PDF ............................................................................................................. 10

10. Run the PDF Accessibility Checker ........................................................................................................... 10

Notes on how to fix errors ................................................................................................................................. 12

   Set Document Title ..................................................................................................................................... 12

   Define the Tab Order .................................................................................................................................... 13

   Check the Reading Order ............................................................................................................................... 13

   Insert Image Alt-Tags .................................................................................................................................... 16
Visit the ODE Intranet Accessibility Training Webpage for ODE training videos and the test.

There are 7 accessibility Requirements

1. Structure (H1, H2, H3...)
2. Figures (ALT text in images)
3. Hyperlinks (Descriptive links instead of web address – URL)
4. Use List Styles (bulleted, numbered, alpha lists)
5. Use Columns Tool
6. Color Contrast
   a) There is not a section for this due to its simplicity; black text and white background is always best. You must have clear contrast for accessibility – light and dark.
7. Properly formatting tables

1. INSERT A DOCUMENT TITLE

1. File/Info (default)
2. Title: Put cursor where it says “Add a title” and enter a title

Properties

<table>
<thead>
<tr>
<th>Size</th>
<th>Not saved yet</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pages</td>
<td>1</td>
</tr>
<tr>
<td>Words</td>
<td>0</td>
</tr>
<tr>
<td>Total Editing Time</td>
<td>4 Minutes</td>
</tr>
<tr>
<td>Title</td>
<td>Add a title</td>
</tr>
<tr>
<td>Tags</td>
<td>Add a tag</td>
</tr>
<tr>
<td>Comments</td>
<td>Add comments</td>
</tr>
</tbody>
</table>

3. To insert Subject, Author, Category, Keywords, etc. click the down arrow beside “Properties”

Properties

<table>
<thead>
<tr>
<th>Size</th>
<th>Not saved yet</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pages</td>
<td>1</td>
</tr>
</tbody>
</table>

4. Choose “Advanced Properties” and enter as needed
2. USE HEADINGS

WebAIM: Microsoft Word - Headings

Headings are found in the Styles gallery on the Home ribbon

A uniform heading structure is often the most important accessibility consideration in Word documents.

Structure through hierarchy - Pages should be structured in a hierarchical manner using Styles. Heading Styles must go in descending/ascending order, do not skip from Heading 1 to Heading 3, etc.

- A **Heading 1** is usually a page title or a main content heading. It is the most important heading, and there is generally just one.
- A **Heading 2** is usually a major section heading.
- A **Heading 3** is usually a sub-section of the Heading 2.
- A **Heading 4** is usually a sub-section of the Heading 3, and so on, ending with Heading 6.

Note: If you use Word Themes, the “Title” Style is used as the title of the document instead of Heading 1. You are welcome to use it without a theme as well.

**Table of Contents**: This feature is activated by using Headings. If you have used headings, go to Reference/Table of Contents to insert.
TO INSERT A HEADING:

1. Type the text you want for the Heading and highlight
2. Click on the appropriate Heading
3. Now the text is formatted to that Style and if you put the cursor in the text the Style you chose will be indicated in the ribbon

TO CHECK THE HEADINGS HIERARCHY:

1. Click on the “View” tab
2. Enter a check for the Navigation Pane
3. This will bring up a panel on the left of your document allowing you to review the headings.

TO FORMAT A HEADING:

1. Right-click on the desired heading in the ribbon
2. Choose “Modify” and the “Modify Style” panel will open
3. Make your desired changes
4. Click “OK”
3. FORMAT TEXT

**Emphasis**

Instead of highlighting text and clicking the Bold, Italics or Underline button, use the “Emphasis” Styles. Click on the lower down arrow to see all Styles.

![Emphasis Styles](image)

**Design**

To change the over-all look/Style of the document use the Design tab or “Change Styles” Button depending on your home ribbon.

4. INSERT ALT-TAGS

*WebAIM: Microsoft Word – Alternative Text for Images*

You will need to add an Alt-Tag and a Description for every image, graphic and video.

1. Right-click on image, choose “Format Picture”

![Format Picture](image)

2. Click on “Layout and Properties” icon (black square icon)
3. Click down arrow next to “Alt text”

![Format Picture](image)
4. Enter a descriptive Title (alt-tag)
5. Each item’s alt-tag must be unique, you can number them if it is a picture of the same object (balloon 1, balloon 2, etc.)
6. Enter a description (otherwise the alt-tag won’t transfer to pdf). Describe what the picture conveys, if image is very simple, just copy and paste the Title.
7. Keep in mind: Items should be “Inline” with the text, otherwise there will be a warning in the accessibility checker. It can be “Inline Wrap Text”, or “Inline Top and Bottom Text”.

5. INSERT HYPERLINKS

WebAIM: Microsoft Word - Links

Use descriptive text for the link instead of the actual web address (URL) or using “Click Here”.

Incorrect example:

- “Click here to access the Microsoft Office Website: http://office.microsoft.com/en-ca/word-help/creating-accessible-word-documents-HA1019999993.aspx”

Incorrect example:

- “For more information about Microsoft tools Click here”

Correct example:

- “For more information about Microsoft tools please visit the Microsoft Office Website.”

6. INSERT LISTS/COLUMNS

Lists and columns add important hierarchical structure to a document. Sometimes users create "lists" and "columns" manually by hitting “Tab” to indent content. While this provides visual structure for sighted users, it does not provide the document structure needed for assistive technology users.

List types: There are two types of lists used in Word, ordered and unordered.

Ordered (numbered) lists are used to present a group of items (words, phrases, sentences) that follow a sequence:

1. Preheat grill with "high" heat setting.
2. Cook hamburgers on "medium" heat setting.
3. Flip hamburgers when juices are visible on the top of the patty.
4. Remove hamburgers when the inside temperature is 160°F.

Unordered (bullet) lists are used for a group of items without a sequence:

- Ketchup
- Mustard
- Pickles
- Onions
7. INSERT TABLES

WebAIM: Microsoft Word – Data Tables

The purpose of data tables is to present information in a grid, or matrix, and to have columns or rows that show the meaning of the information in the grid. Sighted users scan a table to make associations between data in the table and their appropriate row and/or column headers. Screen reader users make these same associations with tables in web pages and PDF files. Unfortunately, Word documents do not support this functionality.

1. Insert the table
2. Insert an Alt-Tag
   a. Right-Click on the table icon located at the top left of the table
   b. Choose “Table Properties”
   c. Go to the “Alt Text” tab
   d. Enter a Title for the table
   e. Enter a Description for the table
   f. Click “OK”

3. Enter a clear heading in EACH column of the top row

<table>
<thead>
<tr>
<th></th>
<th>Option 1</th>
<th>Option 2</th>
<th>Option 3</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

4. Make the first row a “Header” row
a. Highlight first row
b. Table Tools/Design

c. Make sure “Header Row” is checked

d. Table Tools/Layout

e. Click on “Repeat Header Rows”

Note:
- You cannot use merged or split cells
- Go into Table Properties and be sure “Allow row to break across pages” is NOT checked. If a row breaks across a page it causes a “Regularity – Failed” table error.
- Use the options in the Table Tools/Layout tab to format/design the table. This will keep it accessible.

8. RUN WORD ACCESSIBILITY CHECK

WebAIM: Microsoft Word – Accessibility Checker

1. File
2. Info (if using Microsoft Office 2013 or older you will then need to select “Prepare for Sharing”)
3. Click the down arrow on “Check for Issues”
4. Choose “Check Accessibility”

5. A panel shows up on the right side of your document and describes the issues that were found. It will also provide solutions for those issues

6. You **MUST** fix all errors. You **may** fix the warnings.

Common issues:

- ALT text for images, graphics, videos and tables
- Table heading and blank cells (header row, column headings, remove blank cells in table, use layout spacing as needed)
- Useful hyperlink text
• Extra blank spaces (use formatting and Styles to create white space if needed)

8. SAVE THE WORD DOCUMENT AS A PDF

1. File/Export
2. “Create PDF/XPS Document”
3. Click on the “Create PDF/XPS” icon

This will create a PDF/A version, which is the proper version for web posting, however it does not allow you to make edits for accessibility. To make it editable click “Enable Editing” in the far right of the blue ribbon above the document (The blue ribbon will say “This file claims compliance with the PDF/A standard and has been opened read-only to prevent modification” with an “Enable Editing” button on the right).

10. RUN THE PDF ACCESSIBILITY CHECKER

Create and verify PDF Accessibility

1. Tools/Accessibility/Full Check
2. Don’t change the default settings and click “Start Checking”
3. The results are displayed in the Accessibility Checker panel in a tree format, which allows the user to navigate through each error. Errors are shown in **bold** with a red circle and a white “X”.

4. Right-Click on the Error and click “Show Report”, this will open the Accessibility Report in the Accessibility panel.
5. The Accessibility Report shows each section heading and subsection from the Accessibility Checker and each subsection is a hyperlink to a webpage with instructions on how to fix the error.
   a. For the above Accessibility Checker there is a Document “Title – Failed” error. I would go to the Document section of the Accessibility Report and click on the text “Title” which is a hyperlink to a webpage with directions on how to fix that error.

6. Check each error and follow the directions on how to fix the error.
7. If at all possible you will want to fix the error in the source document rather than in the PDF.
8. Once you have fixed each error
9. Save the document
10. Run the Accessibility Checker again.
11. Keep fixing until there are no errors (warnings are fine if you have looked at them and know they are ok)
12. Save the document

If you would like to convert the document back to the PDF/A format [here are directions by Adobe to do that](#).
NOTES ON HOW TO FIX ERRORS

Create and verify PDF Accessibility

You will NOT be able to check accessibility with Adobe Acrobat Reader DC. You must have an Adobe Acrobat Pro product. Adobe Acrobat DC was used to create this instructional manual.

SET DOCUMENT TITLE

If you properly titled the Word document, it will transfer over to the PDF. However, Adobe Acrobat Pro defaults the title of the document to the file name rather than the document title. If you do not set the document title you will receive a Document “Title – Failed” error in the accessibility checker.

1. File/Properties/ “Description” tab

   ![Document Properties](image)

2. Make sure there is a document title, if not, enter one (and enter one into the Word document)

3. Go to the “Initial View” tab

4. Under the “Window Options”, click the down arrow from “Show:” which by default says “File Name” and change it to “Document Title”

5. Click “OK”
**Define the Tab Order**

This step ensures hyperlinks, form fields, comments and images will be read in the correct order. If you do not do this, you will receive a Page Content “Tab order – Failed” error.

If you used the “Save as Adobe PDF” feature in the File menu available with Microsoft Word 2016 you can skip this step.

1. Click on the “Page Thumbnails” icon on the left
2. Click on the first thumbnail page in the Page Thumbnails panel
3. Click “Ctrl-Shift-End” to highlight all the pages
4. Right-Click on any of the highlighted pages and choose “Page Properties”
5. Under the “Tab Order” tab change from “Unspecified” to “Use Document Structure”
6. Click “OK”
7. Minimize the “Page Thumbnails” panel

---

**Check the Reading Order**

You will need to adjust the Document’s Reading Order if there are any images, graphics or tables in the PDF

1. Tools/Accessibility/Reading Order
2. In the Touch Up Reading Order panel, click on “Show Order Panel”
3. This will open an “Order” panel from the left showing the list of pages, their content areas and the order in which they will be read
   a. Note 4, 7, 10 & 11 under Page 1

4. In the document you will see numbered sections representing each item
5. You will want the electronic reader to skip images and anything else that isn’t text. In the example below – 4, 7, 10 & 11 content areas will need to be “skipped” in the reading order.
To skip items in the reading order, Right-Click on the item in the Order Panel and choose “Delete Selected Item Structure”. These items will no longer be listed in the Order panel. You can select multiple items at once by holding down the Ctrl key. The examples below show what the Order panel and the page looks like once 4, 7, 10 & 11 were skipped and no longer listed.
7. Look over the document to be sure the reading sections/groups will be read in the correct order
8. To change the order, you can drag and drop within the Show Order Panel
9. To delete the wrong order and create the right order:
   a. Right-Click on the wrong order items and select “Delete Selected Item Structure”. You will see the highlighted sections with a number indicating the order it would be read disappear from the document.
   b. Take your cursor and create a rectangle around the section/group of text you want to be read
   c. Right-Click on the section you created in the document or In the Touch Up Reading Order Panel choose what type of text it is (Text, figure, Heading 1, Heading 2, etc.)
   d. The group will now show up in the Reading Order Panel
   e. Do this for each section/group that will need to be read that isn’t already an item in the Show Order Panel
   f. You can drag and drop the order if you want to edit the order in which the items are read
10. Tables: Be sure to select tables and designate them as “Tables” to ensure correct reading order

---

**INSERT IMAGE ALT-TAGS**

If you properly tagged all images, videos, tables, etc. in Word then you should not have to insert Alt-Tags in the PDF version. If they were not properly tagged, you will receive an Alternate Text “Figures alternate text – Failed” error.

Here are the directions to add an Alt-Tag in Adobe Acrobat XI Pro.

1. To view the “Tag” panel on the left choose View/Show/Hide/Navigation Panes/Tags
2. Click the “+” buttons to have all the sections showing
3. Right-Click on the item needing an Alt-Tag (most likely will be indicated as “Figure”) and choose “Properties”
4. The Object Properties panel opens and you can add the Title, etc.

5. Click “Close”
6. The examples below show the Object Properties filled out and the Tags panel showing the first Figure with a tag (the second Figure has not been tagged yet)
This is an example of the Heading 1 Styles.